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1 Inhalte des EndNote Basiskurses 

Im EndNote Basiskurs wurden folgende Themen behandelt, die für den EndNote Aufbaukurs 
vorausgesetzt werden: 

• Titel in Endnote aufnehmen (manuelle Eingabe, Import aus dem Online-Katalog der TUM, 

Import aus einer Datenbank, Literatur über die Online-Search-Funktion in EndNote aufnehmen) 

• Grundkenntnisse, wie man Literatur in EndNote in Gruppen organisiert und Literatur in der 

eigenen Library über die Suchfunktion in EndNote findet 

• Arbeiten mit dem Word-Add-In (Quellennachweise in Word einfügen und Literaturlisten im 

gewählten Zitationsstil formatieren lassen) 

Das aktuelle EndNote Basiskurs Skript finden Sie hier:  

https://mediatum.ub.tum.de/node?id=1100719  

 

2 PDF Handling in EndNote  

In EndNotes integriertem PDF-Viewer können Sie PDFs lesen und annotieren. Sie können dem 

PDF Kommentare hinzufügen, die Sie später über die Suchfunktion in EndNote gezielt 

durchsuchen können. Und Sie können die oft nichtssagenden Dateinamen heruntergeladener 

PDFs in sprechende Namen ändern. Außerdem bietet Ihnen EndNote eine Funktion, um im 

Internet nach frei verfügbaren Volltexten zu suchen oder PDFs, die schon auf Ihrem Rechner 

gespeichert sind, in EndNote zu importieren. 

2.1 PDFs annotieren 

In der Summary-Ansicht des Vorschau- und 

Editierbereiches wird Ihnen angezeigt, ob ein 

PDF-Dokument hinterlegt ist. Über Open im 

Drop-down Menü des PDFs öffnet sich das 

PDF in einem neuen Fenster. Hier fügen Sie 

Kommentare und Markierungen in Ihr PDF 

ein (Abb. 1).  

Öffnen Sie mit einem Klick auf das 

Kommentarsymbol (1) die Leiste für 

verschiedene Bearbeitungsmöglichkeiten (2): 

Markierungen (Highlight selected text – 

Textmarkerfunktion), Unterstreichungen 

(Underline selected text), Durchstreichungen 

(Strikeout selected text) und Kommentare 

(Add a sticky note - Notizzettelfunktion). Alle 

Änderungen, die Sie im PDF-Reader in EndNote 

vornehmen, werden Ihnen auch angezeigt, wenn Sie das Dokument im Adobe Acrobat Reader 

öffnen. Nehmen Sie über den Acrobat Reader weitere Änderungen vor, achten Sie beim Speichern 

Abbildung 1: PDF-Viewer in EndNote 

https://mediatum.ub.tum.de/node?id=1100719
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darauf, die bestehende verlinkte Datei zu ersetzen. Andernfalls wird eine Kopie der Datei angelegt, 

die nicht mit dem Datensatz in EndNote verknüpft ist.  

Innerhalb von EndNote bieten die Suchkategorien Any Field + PDF with Notes, PDF und PDF-

Notes in der Advanced search die Möglichkeit gezielt, sowohl nach den eigenen Kommentaren zu 

suchen als auch den PDF-Volltext zu durchsuchen. Dies gilt nur für PDF-Dokumente, die 

maschinenlesbar sind. Texte, die eingescannt und nicht mit OCR-Erkennung bearbeitet wurden, 

können nicht durchsucht werden.   

2.2 Ordner mit PDFs importieren 

In EndNote haben Sie die Möglichkeit, einen ganzen Ordner inklusive Unterordnern mit 

enthaltenen PDFs zu importieren.  Wählen Sie im Menü File => Import => Folder. Es öffnet sich 

das Import Folder-Dialogfenster (Abb. 2). Im Feld Import Folder wählen Sie den gewünschten 

Ordner auf Ihrem Rechner aus. Wählen Sie im Feld Duplicates, wie mit Dubletten umgegangen 

werden soll.  

Sie haben außerdem die Möglichkeit, 

Unterordner einzubeziehen und sich ein Group 

Set für diesen Ordner anlegen zu lassen. Sofern 

Ihr gewählter Ordner Unterordner enthält, 

werden diese als Custom Groups übernommen. 

Nach dem Import wird Ihnen - sofern Sie diese 

Option gewählt haben - der importierte Ordner 

als Group Set in der Navigation Ihrer Local 

Library angezeigt. Eventuelle Unterordner 

werden als Custom Groups übernommen. 

Anderenfalls erscheinen die PDFs im Ordner 

Imported References. 

Sie werden vielleicht feststellen, dass EndNote beim Import nicht für alle PDFs die richtigen 

Titeldaten übernimmt.  

EndNote sucht im PDF zunächst nach einer DOI und recherchiert die entsprechenden Titeldaten 

im Internet. Enthält das PDF jedoch keine DOI oder handelt es sich um ein gescanntes, nicht 

maschinenlesbares PDF, verwendet EndNote die Metadaten des Dokumentes als Titeldaten. In 

vielen Fällen ist hier nur der Name der Datei vorhanden (s. Abb. 3).  

 

Abbildung 2: Dialogfenster für den PDF-Import 
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In diesem Fall bedarf es einer Nachbearbeitung der Daten. Wissen Sie die DOI des Artikels, tragen 

Sie diese in das entsprechende Feld ein und wählen im Menü References die Funktion Find 

Reference Updates. Ist keine DOI bekannt, tragen Sie von Hand Autor, Titel und Jahr in die 

entsprechenden Felder und wählen ebenfalls die Funktion Find Reference Updates. 

Prüfen Sie bei allen Datensätzen, ob die gefundenen Angaben korrekt sind – auch bei denen, die 

EndNote automatisch ergänzt hat. 

 

2.3 Auto Import Folder 

Neben dem manuellen Import von PDFs oder 

Ordnern können Sie auch einen Ordner 

festlegen, aus dem neue PDFs automatisch 

in EndNote importiert werden. D.h. jedes Mal, 

wenn Sie EndNote öffnen, prüft EndNote, ob 

dem ausgewählten Ordner neue PDFs 

hinzugefügt wurden und importiert diese 

dann automatisch.  

Gehen Sie dazu im Menü Edit auf 

Preferences und dann in den Bereich PDF 

Handling. Dort können Sie im Bereich PDF 

Auto Import Folder einen Ordner festlegen, 

aus dem PDFs automatisch importiert 

werden (Abb. 4). 

Sind im ausgewählten Ordner Unterordner 

enthalten, können die PDFs (anders als beim normalen Import) nicht aus diesen Unterordnern 

importiert werden.  

 

  

Abbildung 4: Auto-Import-Folder einrichten 

Abbildung 3: Titelliste importierter PDFs 
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2.4 PDF Namen ersetzen 

Häufig haben PDF-Dokumente, die Sie sich aus Datenbanken herunterladen, kryptische, wenig 

aussagekräftige Namen. EndNote bietet die Möglichkeit, diese nach einem von Ihnen festgelegten 

Schema neu zu benennen.  

Zum Beispiel durch das Schema Autor – Jahr – Titel. Stellen Sie dies im Menü Edit => Preferences 

=> PDF Handling => PDF Auto Renaming Options ein (Abb. 5). 

 

2.5 Find Full Texts  

Mit dem Befehl Find Full Text im Menü References sucht EndNote automatisch nach frei 

verfügbaren Volltexten. Diese Funktion finden Sie auch im Kontextmenü (Rechtsklick, s. Abb. 6). 

Markieren Sie dafür alle Referenzen, die in der Volltextsuche berücksichtigt werden sollen. 

EndNote kann bei einer Suche nach maximal 150 Titeln suchen.  

Abbildung 5: PDF-Namen ersetzen 

Abbildung 6: Die Find-Full-Text-Suche starten 
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Um immer eine Kopie der Datei in der EndNote Library zu speichern, wählen Sie im Menü Edit den 

Befehl Preferences. Unter dem Punkt URLs und Links setzen Sie dazu das Häkchen bei Copy new 

file attachments to the default file attachment folder and create a relative link. So haben Sie die 

Daten auch dann zur Hand, wenn Sie Dateien verschieben und EndNote eine Datei nicht mehr am 

ursprünglichen Speicherort findet. 

Um nicht jedes Mal, wenn Sie neuen Referenzen in Ihre Library aufnehmen erneut die Find-Full-

Textsuche starten zu müssen, können Sie dies automatisieren. Wählen Sie im Menü Edit => 

Preferences => Find Full Text und setzen Sie das Häkchen bei Automatically invoke Find Full Text 

on newly imported references (s. Abb. 7). 

Um über die Funktion Find Full Text auch von der TUM lizenzierte Volltexte abrufen zu können, 

fügen Sie im Menü Edit => Preferences => Find Full Text unter dem Punkt OpenURL-Path 

folgende URL ein: http://sfx.bib-bvb.de/sfx_tum.  

Wenn Sie sich nicht im Campus-Netz befinden oder per VPN-Client eingeloggt sind, fügen Sie 

unter dem Punkt Authenticate with die URL https://eaccess.ub.tum.de/login ein. So können Sie 

außerhalb des Campus-Netzes nach von der TUM lizenzierten Volltexten suchen. 

 

Abbildung 7: Den OpenURL Path eintragen 

http://sfx.bib-bvb.de/sfx_tum
https://eaccess.ub.tum.de/login
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In diesem Fall werden Sie, wenn Sie die Find-Full-Text-Funktion aufrufen, zunächst auf die 

eAccess-Log-In-Seite der TUM geleitet. Authentifizieren Sie sich hier mit Ihrer TUM-Kennung 

(TUM-E-Mailadresse + Passwort), klicken Sie auf Log-In und anschließend auf Continue. 

Beachten Sie, dass Sie nicht alle an der TUM verfügbaren, lizenzierten elektronischen Volltexte 

finden werden. Ergibt die Find-Full-Text-Suche keine Ergebnisse, ist es daher sinnvoll, noch 

einmal selber in den lizenzierten Datenbanken an der TUM zu recherchieren. Suchen Sie nach 

lizenzierten Volltexten, kann es außerdem zu längeren Suchzeiten kommen. 

Wollen Sie die Volltextsuche abbrechen, klicken Sie in der Navigation unter dem Punkt Find Full 

Text per Rechtsklick auf den Status Searching. Pausieren Sie die Suche oder brechen Sie diese 

ab (Abb. 8). 

 

Abbildung 8: Volltextsuche pausieren oder abbrechen 

Volltexte in EndNote Web / Online 

Volltexte können entweder direkt in EndNote Web gespeichert oder über die 

Synchronisationsfunktion hinzugefügt und mit anderen Geräten synchronisiert werden.  

Während Sie Ihre Referenzen über EndNote Web mit anderen EndNote Web Nutzern teilen 

können, ist dies für Volltexte bis einschließlich Version X7.1 nicht möglich. Erst Version X7.2 bietet 

diese Option über die Funktion Share Library an. 

 

3 Literatur in EndNote organisieren und finden 

Welche Möglichkeiten haben Sie, Ihre Literatur in EndNote zu sortieren? 

Entscheiden Sie, welche Informationen Sie in welcher Reihenfolge im Inhaltsfenster angezeigt 

bekommen wollen. Ordnen Sie Ihre Literatur in Custom, Combo und Smart Groups. Bewerten Sie 

Ihre Literatur und behalten Sie die Übersicht, welche Literatur Sie bereits gelesen haben und 

welche noch nicht.  

Verwenden Sie Keywords, um schnell Titel zu einem Thema wieder zu finden, und halten Sie Ihre 

Daten mit Hilfe von Term Lists und Dublettensuche konsistent.  
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3.1 Angezeigte Spalten  

Per Linksklick auf eine der Spaltenüberschriften (Author, Title, etc.) werden Ihre Einträge 

alphabetisch bzw. nach Größe sortiert. Die Reihenfolge der Spalten können Sie über einfaches 

Drag-and-Drop verändern (Abb. 9).  

Per Rechtsklick auf eine Spaltenüberschrift wählen Sie, welche Informationen angezeigt werden 

sollen und welche nicht (Abb. 10). 

3.2 Bewertung & Gelesen/Ungelesen-Status 

Im Feld Rating bewerten Sie Ihre Literatur mittels eines 5-

Sternesystems. Nach Literatur mit einem bestimmten Rating lässt sich 

auch gezielt suchen. Ihre Bewertung können Sie auch als Kriterium 

für eine neue Smart Group verwenden.  

Um im Blick zu behalten, welche Literatur Sie bereits gelesen haben 

und welche noch nicht, bietet EndNote die Read/Unread-Kategorie. 

Ungelesene Referenzen werden durch einen grauen Punkt, bereits 

gelesene durch einen grauen Punkt mit Häkchen gekennzeichnet.  

3.3 Groups 

EndNote ermöglicht die Untergliederung der Daten in Gruppen (sog. Groups) und unterscheidet 

hier Custom Groups, Smart Groups und Combo (= combined) Groups (s. Abb. 11). Den Custom 

Groups ordnen Sie Datensätze per Hand zu. Die Smart Groups beruhen auf einer von Ihnen 

erstellten Suchanfrage und werden automatisch aktualisiert. Die Combo Groups (From Groups) 

führen die Titel mehrerer Custom und Smart Groups zusammen. Auch sie werden automatisch 

aktualisiert. Inhaltlich zusammengehörende Gruppen können durch Group Sets gebündelt werden. 

Group Sets sind Überschriften, die mehrere Gruppen bündeln, sie selbst enthalten keine 

Referenzen. 

Abbildung 9: Spalten sortieren und verschieben 

Abbildung 10:Angezeigte 
Spalten 
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3.3.1 Group Sets 

So erstellen Sie ein Group Set: 

1. Wählen Sie aus dem Menü Groups den Befehl Create Group Set. 

2. Vergeben Sie für das neue Group Set einen Namen. 

 

3.3.2 Custom Groups 

So erstellen Sie eine Custom Group: 

1. Klicken Sie mit der rechten Maustaste auf das Group Set, in dem die Custom Group erstellt 

werden soll. 

2. Wählen Sie aus dem geöffneten Kontextmenü den Befehl Create Group aus. 

3. Vergeben Sie für die neue Custom Group einen Namen. 

 

So fügen Sie Daten in eine Custom Group ein: 

1. Markieren Sie die Datensätze in der Übersicht. 

2. Ziehen Sie die Datensätze per Drag-and-Drop in die gewünschte Gruppe oder markieren Sie 

die gewünschten Datensätze und wählen Sie im Kontextmenü > Add References To > und 

wählen dann die gewünschte Custom Group aus. 

 

3.3.3 Smart Groups 

So erstellen Sie eine Smart Group: 

Abbildung 11: Die verschiedenen Gruppen in EndNote 
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1. Klicken Sie mit der rechten Maustaste auf das Group Set, in dem die Smart Group erstellt 

werden soll. 

2. Wählen Sie aus dem geöffneten Kontextmenü den Befehl Create Smart Group aus. 

3. Vergeben Sie für die neue Smart Group einen Namen. 

4. Geben Sie in der geöffneten Suchmaske Ihre Suchstrategie für die Smart Group ein und 

klicken Sie auf den Button Create. Hier können Sie beliebige Kriterien miteinander verknüpfen; 

unter anderem auch Keywords, Rating, Year etc. 

 

3.3.4 Combo Groups 

So erstellen Sie eine Combo Group: 

1. Klicken Sie mit der rechten Maustaste auf das Group Set, in dem die Combo Group erstellt 

werden soll. 

2. Wählen Sie aus dem geöffneten Kontextmenü den Befehl Create From Groups aus. 

3. Vergeben Sie für die neue Combo Group einen Namen. 

4. Geben Sie an, aus welchen Custom und/oder Smart Groups Sie Titel in Ihrer neuen Combo 

Group zusammenführen wollen. 

5. Wollen Sie die Suchanfrage der Smart Group noch einmal verändern, klicken Sie auf die 

Smart Group und wählen im Kontextmenü Edit Group. 

 

ACHTUNG 

Ein Datensatz kann mehreren Gruppen angehören, ist aber dennoch nur einmal in der Datenbank 

gespeichert. Wird ein Datensatz aus der Custom Group entfernt, wird er nicht komplett aus der 

EndNote Library, sondern nur aus der Custom Group gelöscht. 

Löschen Sie dagegen einen Titel aus einer Smart Group oder einer Combo Group, wird dieser 

ohne Warnung vollständig aus der Datenbank/Library gelöscht! Bis Sie EndNote schließen, finden 

Sie die gelöschten Datensätze noch im Trash Ordner. 

Woher weiß ich, welchen Groups eine Referenz zugeordnet ist? 

Markieren Sie die gewünschte Referenz und wählen Sie im Kontextmenü References => 

Reference Summary. Es werden alle Gruppen, denen diese Referenz zugeordnet ist, angezeigt. 

Dabei wird nicht unterschieden zwischen Custom und Smart Groups.  

3.4 Keywords 

Um Ihre Literatur zu einem bestimmten Thema immer schnell bei der Hand zu haben, bietet es 

sich an, inhaltsbeschreibende Begriffe zu vergeben – sogenannte Keywords. Nach diesen 

Keywords können Sie in EndNote suchen, so dass Sie Ihre Referenzen auch dann finden, wenn 

das Thema im Titel anders benannt ist oder im Titel gar nicht auftaucht. Sie können sie als 

Kriterium für Smart Groups verwenden und Literaturlisten dazu erstellen.  

Einem Datensatz lassen sich beliebig viele Keywords zuordnen. Geben Sie die Keywords im Feld 

Keyword jeweils in eine neue Zeile ein. EndNote sammelt alle Keywords in einer Term List. Über 

die Term List haben Sie immer einen guten Überblick, welche Keywords Sie bereits verwendet 

haben.  
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Die Term List lässt sich über die Tastenkombination Strg + 1 öffnen, wenn der Cursor im Keyword-

Feld steht oder über das Menü Library => Open Term Lists => Keywords Term List. 

3.5 Term Lists 

Für die Felder Author, Journal und Keyword pflegt EndNote automatisch Listen. D.h. jeder in 

diesem Feld eingegebene Eintrag wird in der entsprechenden Liste gespeichert. Dies dient der 

Vereinheitlichung von Bezeichnungen. So kommt es zum Beispiel häufig vor, dass ein Autor, von 

dem aus verschiedenen Datenbanken Literatur importiert wird, unterschiedlich benannt ist. Einmal 

wird der Vorname ausgeschrieben, ein anderes Mal werden nur die Initialen genannt. Über die 

Term Lists stellen Sie sicher, dass ein Autor, von dem Sie verschiedene Werke zitieren, in Ihrem 

Literaturverzeichnis immer gleich benannt ist.  

Term Lists werden automatisch mit dem ersten Eintrag angelegt (im Programm erkennen Sie 

einen Neueintrag an der roten Schriftfarbe). Sie können diese aber auch gezielt selber erstellen 

oder fertige Term Lists von EndNote importieren. Insbesondere für die Journals‘ Term Lists lohnt 

es sich die angebotenen Listen von EndNote zu importieren, da hier unterschiedliche 

Abkürzungsvarianten eines Zeitschriftentitels hinterlegt sind (s. Abb. 12). Die Listen werden von 

EndNote für unterschiedliche Fachbereiche mitgeliefert und sind im Ordner Terms Lists abgelegt. 

Über das Menü Library => Open Term Lists lassen sich die einzelnen Term Lists öffnen. Im Tab 

Terms sehen Sie alle in der Term List enthaltenen Begriffe. Im Tab Lists wechseln Sie zwischen 

den Listen und im- oder exportieren Ihre Term Lists.  

Für Journals: Wenn Sie schon Journals in Ihrer Library gesammelt haben, löschen Sie zunächst 

alle Titel im Tab Terms. Importieren Sie dann im Tab Lists die gewünschten Listen und ergänzen 

Abbildung 12: Die Journals Term List in EndNote 
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anschließend die importierte Liste mit Ihren schon vorhandenen Terms über den Button Update 

List. 

3.6 Wie geht EndNote mit Dubletten um? 

In den EndNote Preferences stellen Sie ein, ob und wie EndNote Ihre Library auf Dubletten 

überprüft. Gehen Sie dazu im Menü Edit auf => Preferences => Duplicates. Entscheiden Sie, 

welche Felder für eine Dublettenkontrolle überprüft werden sollen und wie mit Dubletten 

umgegangen wird.  

EndNote prüft nun beim Import von Datensätzen, ob diese bereits in der geöffneten Library 

vorhanden sind.  

Datensätzen, die per Direktimport in die Library aufgenommen werden, werden dabei nicht 

überprüft.  Möchten Sie alle Datensätze in Ihrer Library auf Dubletten hin untersuchen, wählen Sie 

die Funktion Find Duplicates im Menü References.  

3.7 Zurückgezogene Artikel finden 

Ab Version 20.2 bietet EndNote die Funktion „Retractions“. Diese Funktion überprüft automatisch 

bei jedem Öffnen und Schließen EndNotes ob Artikel zurückgezogen wurden. EndNote prüft 

Zeitschriftenartikel, für die in EndNote entweder eine DOI oder eine Pubmed-ID eingetragen ist. 

Außerdem muss die EndNote Library mit einem Online Account verbunden sein (dazu mehr in 

Kap. 7). Die Suche nach zurückgezogenen Artikeln ist dabei unabhängig von der Synchronisation 

der Library. Wenn Sie die automatische Synchronisation deaktiviert haben, ist dies also kein 

Hindernis für EndNote nach zurückgezogenen Artikeln zu suchen. Überprüft werden die Artikel 

anhand der Datenbank „Retraction Watch Database“. Nur wenn die Artikel dort als zurückgezogen 

gelistet sind, „erkennt“ EndNote, dass Sie zurückgezogen wurden.  

Die zurückgezogenen Artikel werden Ihnen in der Navigation im Ordner „Retractions“ angezeigt (s. 

Abb. 13.). Wählen Sie dort einen Titel aus, wird rechts im Summary-Tab ein grau hinterlegter 

Warnhinweis „Retracted publication“ angezeigt. Klicken Sie auf diesen Warnhinweis werden 

weitere Informationen zum Grund der Zurückziehung angezeigt.  

Abbildung 13: Zurückgezogene Artikel finden 

http://retractiondatabase.org/RetractionSearch.aspx?
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3.8 Suche innerhalb EndNotes 

Sie haben in EndNote zwei Möglichkeiten, innerhalb Ihrer Referenzen zu suchen. Die Simple 

search und die Erweiterte Suche (Advanced search).  

 

3.8.1 Simple search & Advanced search  

Das Umschalten zwischen den zwei Suchmöglichkeiten erfolgt jeweils unterhalb des Search 

Panels (Abb. 14).  

Die Simple search durchsucht alle Felder der Library inklusive PDF-Volltext und PDF-

Kommentare. Der gesuchte Begriff wird in der Trefferliste farbig hervorgehoben. Geben Sie einen 

oder mehrere Begriffe in das Quick Search Feld ein und drücken Sie die Enter-Taste. Geben Sie 

mehrere Begriffe ein, werden diese durch UND verknüpft. Diese Suche ist gut geeignet für 

schnelle, allgemeine Suchen.  

Über die Advanced search führen Sie spezielle Suchen durch. Dazu stehen Ihnen beliebig viele 

Suchfelder zur Verfügung, mit denen Sie jeweils ein bestimmtes Feld durchsuchen, wie z.B. 

Author, Title, Keyword etc. Diese Suchfelder lassen sich beliebig mit AND, OR oder NOT 

verknüpfen. Über das Drop-down-Menü Contains spezifizieren Sie, wie Ihr Suchbegriff im 

durchsuchten Feld vorkommen soll. Soll der Begriff im Suchfeld enthalten sein, soll er größer oder 

kleiner sein, am Anfang oder Ende des Feldes stehen (Abb. 15). Über den +-Button rechts neben 

dem Suchschlitz lassen sich weitere Suchfelder hinzufügen. Auch hier ist eine Suche in der 

gesamten Library inklusive Volltexten und PDF-Kommentaren möglich.  

3.8.2 Suchen speichern oder in Smart Groups umwandeln 

Abbildung 14: Suchoptionen in EndNote 

Abbildung 15: Suchfelder in EndNote 
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Diese Suchen können Sie über den Button Search Options speichern oder zu einer Smart Group 

umwandeln.  

3.8.3 In mehreren EndNote Libraries suchen 

Wenn Sie Suchen innerhalb von EndNote durchführen, wird immer nur die geöffnete Library 

durchsucht.  

Die einzige Möglichkeit, eine Suche über mehrere EndNote Libraries hinweg durchzuführen, führt 

über die Insert Citations-Funktion in Word. Haben Sie das EndNote-Plug-In für Word CWYW (Cite 

while you write) installiert, suchen Sie während des Schreibens über diese Funktion nach Ihren 

Quellen. Diese Funktion sucht über alle geöffneten EndNote Libraries auf Ihrem Rechner hinweg. 

In der Statusleiste des Suchfensters wird angezeigt, in welcher EndNote Library der gesuchte Titel 

gespeichert ist (Abb. 16).  

 

  

Abbildung 16: Library-übergreifende Suche über die Insert-Citation-Funktion in Word 
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4 EndNote - Schreiben mit dem Word-Add-In CWYW (Cite 

While You Write) 

Mit dem EndNote Word-Add-In lassen sich Quellenangaben schnell und einfach in den Text 

einfügen. Mit der ersten Referenz, die Sie in Ihren Text einfügen, erstellt EndNote Ihnen 

automatisch das Literaturverzeichnis. Während Sie an Ihrem Text arbeiten, wird dieses ständig im 

gewählten Zitationsstil aktualisiert und ergänzt. 

4.1 Quellen einfügen 

1. Starten Sie Microsoft Word und öffnen Sie ein neues Dokument. 

2. Öffnen Sie in Word im Menü EndNote 20 die EndNote-Befehle. 

3. Platzieren Sie Ihren Cursor an der Stelle im Text, an der Sie eine Quellenangabe einfügen 

möchten, und wählen Sie Insert Citation aus (Abb. 17). 

4. Geben Sie einen oder mehrere Suchbegriffe (z.B. den Autor, ein Keyword oder einen Begriff 

aus dem Titel der Quelle, die Sie zitieren möchten) in das sich öffnende Suchfenster ein und 

klicken Sie auf den Button Find. Alle Referenzen, die Ihre Suchkriterien erfüllen, werden 

angezeigt. Diese Funktion sucht in allen geöffneten EndNote Libraries. Dies ist die einzige 

Möglichkeit, Ihre Literatur library-übergreifend zu suchen. Wollen Sie sich alle Referenzen, die 

Sie in Ihrer EndNote Library gespeichert haben, anzeigen lassen, fügen Sie in das Suchfeld 

ein * ein.  

5. Markieren Sie die Referenz(en), die Sie in den Text einfügen möchten, und klicken Sie auf den 

Button Insert. 

6. EndNote fügt die Referenz(en) in Ihr Dokument ein und erstellt den dazugehörigen Eintrag im 

Literaturverzeichnis im ausgewählten Zitationsstil (Output Style). 

Auch für den Open Office Writer unter Windows und Apple Pages steht CWYW zur Verfügung. 

4.2 Fußnoten hinzufügen 

Wollen Sie einen Fußnotenstil verwenden, setzen Sie zunächst über die Wordfunktion Fußnote 

einfügen im Menü Verweise eine Fußnote. Setzen Sie dann den Cursor in die Fußnote und wählen 

Sie Ihre Quellenangabe aus, wie in den Punkten 4.1., 2-6 beschrieben. 

4.3 Seitenangaben hinzufügen 

Über den Button Edit & Manage Citation(s) werden zusätzliche Angaben wie beispielsweise 

Seitenangaben der zitierten Quelle hinzugefügt. Würden Sie diese Angaben von Hand in die 

Abbildung 17: EndNote-Menü in Word 



 
Universitätsbibliothek 

Technische Universität München 

18 / 44 

Quellenangabe im Text einfügen, würden Ihre Ergänzungen bei der nächsten Aktualisierung des 

Dokumentes von EndNote überschrieben, da es sich bei der Quellenangabe um eine Feldunktion 

handelt, die automatisch mit der EndNote Library abgeglichen wird.  

4.4 Literaturverzeichnisse formatieren – Zitationsstile wechseln 

Sobald Sie über das EndNote Word-Add-In die erste Quellenangabe in Ihren Text einbinden, 

erstellt EndNote automatisch am Ende des Textdokumentes ein Literaturverzeichnis, das laufend 

aktualisiert wird.  

Über das Drop-down-Menü Style wählen Sie den gewünschten Zitationsstil. Hier werden Ihnen die 

am häufigsten verwendeten Zitationsstile angezeigt. Über den Button Select another style können 

Sie unter allen in EndNote installierten Zitationsstilen wählen. Zusätzlich zu den in EndNote 

installierten Zitationsstilen lassen sich über die EndNote Website zahlreiche weitere Stile 

hinzufügen.  

Um einen neuen Zitationsstil hinzuzufügen, speichern Sie den neuen Stil im Ordner Styles 

(C:\Program Files (x86)\EndNote X20\Styles). 

Über den Button Bibliography (auch Configure Bibliography oder Bibliography Settings) bestimmen 

Sie Layout und Überschrift der Literaturliste.  

4.5 Literaturverzeichnisse gruppieren 

Literaturverzeichnisse werden i.d.R. alphabetisch oder in der Reihenfolge, in der die Quellen im 

Text zitiert wurden, sortiert. Manchmal ist es jedoch gewünscht, einen Teil der Quellen getrennt 

von den anderen anzuzeigen – z.B. die Internetquellen getrennt vom Rest der zitierten Literatur 

oder Primär- und Sekundärliteratur getrennt. Dazu gibt es im Word-Add-In die Funktion Categorize 

References (s. Abb. 18). Legen Sie die gewünschten Kategorien über Configure Categories an. 

Abbildung 18: Kategorien in Word 
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Die Kategorien (Category Headings) Primary Sources und Secondary Sources sind schon 

angelegt. Über +Category Headings legen Sie neue Kategorien an (s. Abb. 19). Per Drag-and-

Drop ziehen Sie die Referenzen aus den All References in Bibliography in die gewünschte 

Kategorie. Eine automatische Zuordnung z.B. über Custom oder Smart Groups ist nicht möglich. 

 

4.6 EndNote-Formatvorlagen in Word ändern 

Während das Literaturverzeichnis inhaltlich vom Zitationsstil bestimmt wird, wird die Formatierung 

über die Formatvorlagen definiert. Sobald Sie mit EndNotes Word-Add-In die erste Quellenangabe 

in Ihren Text eingefügt haben, finden Sie in Word zwei zusätzliche Formatvorlagen (s. Abb. 20); 

die Vorlage EndNote Bibliography für die Einträge im Literaturverzeichnis und EndNote 

Bibliography Title für die Überschrift des Literaturverzeichnisses.  

Abbildung 19: Neue Kategorien anlegen und Literatur zuordnen 
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Über das kleine Drop-down-Menü neben dem Namen der Formatvorlage, haben Sie die 

Möglichkeit diese Vorlage zu verändern (s. Abb. 20). 

Über die Formatvorlage können Sie Schriftart und -größe, Zeilenabstände, aber auch die Abstände 

zwischen einzelnen Einträgen im Literaturverzeichnis anpassen (s. Abb. 21).  

Abbildung 20: EndNote Formatvorlagen in Word 
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4.7 Die Travelling Library 

Eine Travelling Library wird angelegt, sobald in einem Textdokument mit EndNote die erste Quelle 

eingefügt wird. Die Travelling Library enthält die bibliographischen Daten aller in diesem Word-

Dokument zitierten Quellen mit Ausnahme der Felder Notes, Abstract und Research Notes.  

Eine Travelling Library kann von anderen EndNote-Usern aus dem Word-Dokument nach EndNote 

exportiert werden. Werden diese Datensätze dann in EndNote verändert, werden die Änderungen 

auch in Word angezeigt.  Voraussetzung für alle Aktualisierungen in Word ist immer, dass die 

verwendete(n) EndNote Libraries geöffnet ist / sind. Andernfalls werden die in der Travelling 

Library hinterlegten Daten zur Aktualisierung verwendet.  

Beim Import einer Travelling Library werden die Datensätze auf Dubletten hin kontrolliert.  

Abbildung 21: Formatvorlagen in Word anpassen 
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4.8 Wo sehe ich in EndNote, welche Quellen ich in meinem Word-Dokument 

bereits zitiert habe?  

In EndNote wird ein temporärer Ordner mit dem Namen der Word-Datei angelegt (Abb. 22). Dieser 

ist nur so lange zu sehen, wie das Word-Dokument geöffnet ist und enthält alle schon zitierten 

Quellen. 

4.9 Geschwindigkeit in Word – Instant Formatting 

Stellen Sie fest, dass es in Word besonders lange dauert, bis 

neue Referenzen eingefügt werden, deaktivieren Sie die 

Funktion Instant Formatting vorübergehend, während Sie am 

Dokument arbeiten. Wählen Sie im EndNote-Menü in Word den 

Button Instant Formatting is On und stellen Sie die permanente 

Formatierung aus. Weitere Einstellungen zum Instant 

Formatting können Sie in den EndNote Preferences in Word 

unter Preferences > Tab General vornehmen. Um zu einem 

späteren Zeitpunkt Zitationen und Literaturverzeichnis zu 

formatieren, aktivieren Sie diese Funktion wieder. 

5 Literaturlisten nach Schlagworten, Autoren oder Jahren 

erstellen 

Um eine Literaturliste Ihrer gesammelten Literatur nach bestimmten Kriterien wie z.B. Schlagwort, 

Autor oder Jahr zu erstellen, wählen Sie im Menü Tools => Subject Bibliography. 

 

Abbildung 23: Literaturlisten nach Schlagworten, Autoren oder Jahren 
erstellen 

Abbildung 22: Liste zitierter Referenzen 
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Wählen Sie im Dialogfeld Subject Fields das Kriterium oder die Kriterien, nach denen die Liste 

sortiert werden soll (Abb. 23).  

Wollen Sie eine nach Autoren sortierte Liste, gibt es die Möglichkeit, sich jeden Autor einzeln 

anzeigen zu lassen (List each author seperately). Dies bedeutet, dass Werke, die von mehreren 

Autoren stammen, unter jedem Autorennamen und damit mehrfach in der Liste aufgeführt sind. 

Klicken Sie anschließend auf OK. 

Im nun folgenden Dialogfenster werden Ihnen alle Einträge eines Kriteriums aufgelistet und es wird 

angezeigt, wie viele Referenzen jeweils gefunden wurden (Abb. 24).  

Wählen Sie z.B. eine Liste, die nach Schlagworten sortiert sein soll, werden hier alle Schlagworte 

mit der entsprechenden Titelanzahl aufgelistet. 

Wählen Sie hier alle (Select All), wenn Sie eine vollständige Liste möchten, oder markieren Sie per 

Mausklick alle Begriffe, die Sie übernehmen wollen. Klicken Sie anschließend auf OK. 

Ihre Literaturliste wird erstellt und in einem Vorschaufenster angezeigt (Abb. 25). 

Abbildung 24: Schlagworte für Literaturlisten auswählen 
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Pro Keyword wird Ihnen in Klammern angegeben, wie viele Titel in Ihrer Library dazu vorhanden 

sind. Anschließend folgt die Nennung des Titels. Im Drop-down-Menü Output Style wählen Sie, in 

welchem Zitationsstil Ihnen die Liste ausgegeben werden soll. Über den Button Layout können Sie 

noch einige Änderungen am Layout vornehmen oder über den Button Terms… noch einmal 

Schlagworte ausblenden oder zusätzlich einblenden lassen. 

Entscheiden Sie, ob Sie die Liste drucken oder speichern wollen.  

6 Zitationsstil ändern und erstellen 

EndNote bietet Ihnen eine Vielzahl unterschiedlicher Zitationsstile (Output Styles). Diese finden Sie 

in EndNote über das Menü Tools> Output Styles > Open Style Manager. Dort finden Sie eine 

Auswahl aller verfügbaren Stile, die EndNote anbietet. Weitere Stile finden Sie unter: 

http://endnote.com/downloads/styles. 

Im Style Manager finden Sie unten ein Vorschaufenster, in dem der markierten Zitationsstils 

angezeigt wird (Abb. 26, 1). Ggf. müssen Sie die Ansicht über den Button Style Info / Preview (2) 

auf die Vorschauansicht umstellen.  

Abbildung 25: Vorschau der Literaturliste nach Schlagworten 

http://endnote.com/downloads/styles
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Abbildung 26: Output Style Manager 

 

Finden Sie weder hier noch auf der EndNote-Seite einen passenden Stil, gibt es die Möglichkeit, 

einen vorhandenen Stil anzupassen oder einen Stil selbst zu erstellen. Wir empfehlen einen 

möglichst ähnlichen Stil auszuwählen und diesen anzupassen, da es viel Arbeit kostet, einen 

eigenen Stil zu erstellen.  

Wollen Sie einen Stil anpassen, wählen Sie diesen im Style Manager aus und klicken auf Edit, um 

ihn zu verändern (3). Es öffnet sich der Style Editor (Abb. 27).  

Der Zitationsstil definiert, wie eine Zitation im Text (Citation, 2) oder in der Fußnote (Footnotes, 4) 

aussehen soll und wie die Referenz im Literaturverzeichnis dargestellt wird (Bibliography, 3). Je 

nachdem, ob es sich um einen Fußnotenstil handelt oder einen Autor-Jahr-Stil, machen Sie die 

Einstellungen entweder unter 2 oder unter 4. Der Bereich 1 enthält allgemeine Angaben, z.B. wie 

Seitenzahlen und Zeitschriftentitel angegeben werden und ob ein Literaturverzeichnis pro Kapitel 

oder eines für das gesamte Dokument erstellt wird. Im Bereich 5 (Figures & Tables) wird 

festgelegt, wie Abbildungen und Tabellen angegeben werden. Da diese Funktion von EndNote 
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nicht mehr gepflegt wird, empfehlen wir diese nicht zu verwenden, sondern stattdessen die 

originären Word-Funktionen zu nutzen.  

 

6.1 Die Zitation im Text bzw. in der Fußnote 

Wählen Sie links in der Navigation im Bereich Citations (2) bzw. Footnotes (4) den Punkt 

Templates, um die Angabe im Text bzw. in der Fußnote festzulegen. Im Zitationsstil können alle 

Felder, die in EndNote zur Verfügung stehen, verwendet werden, wie z.B. die Felder Author, Title, 

Year etc. Neben den Inhalten der Datenbankfelder können Satzzeichen, Buchstaben sowie 

spezielle Operatoren verwendet werden. Datenbankfelder und Operatoren finden Sie  

  

Abbildung 27: Output Style Editor 
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über den Button Insert Field (Abb. 28). Fügen Sie über die Insert-Field-Funktion z.B. das Feld 

Author ein, wird nicht das Wort Author, sondern der Inhalt dieses Datenbankfeldes in der Zitation 

angegeben. Satzzeichen, die die einzelnen Informationen voneinander trennen, werden von Hand 

eingegeben.  

Dabei ist es wichtig zu berücksichtigen, dass es vorkommen kann, dass ein Feld keinen Inhalt hat. 

Das könnte dazu führen, dass zwei Satzzeichen aufeinander folgen oder ein Text wie z.B. p. für 

die Seitenangaben ohne eine darauffolgende Seitenangabe dargestellt wird. Um das zu verhindern 

gibt es spezielle Operatoren, mit denen Textelemente mit einem Feldinhalt verknüpft werden 

können. Angaben wie p.  oder vorangestellte Satzzeichen sollen nur dann ausgegeben werden, 

wenn auch eine Seitenangabe vorhanden ist.  

Link-Adjacent-Text-Operator 

Mit Hilfe des Operators Link Adjacent Text werden Textelemente und Feldinhalte verknüpft. Das 

Textelement wird nur dann dargestellt, wenn auch das Datenbankfeld einen Inhalt hat. In Abb. 28 

wird dieser Operator durch ein hochgestelltes Kreis-Symbol dargestellt. Ebenso verknüpft man 

Satzzeichen mit ihren Folgeelementen. Ein Link-Adjacent-Text-Operator setzt immer automatisch 

ein Leerzeichen. Den Link-Adjacent-Text-Operator finden Sie z.B. zwischen der Angabe pp. und 

dem Feld Cited Pages. Leerzeichen werden durch einen einfachen Punkt auf der Mitte der 

Zeilenhöhe dargestellt (folgt z.B. dem Komma nach der Autorenangabe).  

Soll der verknüpfte Text genauso lauten, wie der Name des Feldes, soll z.B. nach dem 

Herausgebernamen (Editor) noch das Wort Editor angegeben werden, wird der Text in umgekehrte 

Apostrophe gesetzt `Editor`. 

Abbildung 28: Zitation im Text anpassen 
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Forced-Separation-Operator 

Fehlt ein Feldinhalt, gibt es Text und Zeichen im direkten Umfeld dieser Angabe, die ebenfalls 

nicht dargestellt werden sollen, während alle anderen Informationen normal angegeben werden 

sollen. In einer Definition für eine Zitation im Text gibt es demnach eine Unterteilung in 

Sinnabschnitte. Um EndNote diese Sinnabschnitte zu zeigen, wird den Operator Forced 

Separation (senkrechter Strich) verwendet.  

 

Trifft EndNote nun beim Lesen dieser Definition auf einen Forced Separator, prüft es zunächst, ob 

das folgende Datenbankfeld einen Inhalt hat. Ist dies der Fall, wird die Zitation weitergeschrieben, 

ohne die Operatoren darzustellen. Ist das Datenbankfeld leer, überspringt EndNote alle Angaben 

bis zum nächsten Forced Separator und schreibt erst nach diesem weiter. Um beim Beispiel der 

Seitenangabe aus Abb. 28 zu bleiben, würde bei leerem Cited-Pages-Feld der gesamte Inhalt 

zwischen dem vorangehenden Forced Separator und dem folgenden Forced Separator außer Acht 

gelassen, während die Schließende Klammer nach dem Forced Separator wieder dargestellt 

würde.  

Singular/Plural-Operator 

Unerklärt geblieben ist bisher die Angabe p.ᶺpp. Dies ist eine Funktion, mit der unterschiedliche 

textliche Angaben für Singular und Plural gemachen werden können. Je nachdem, ob der 

verknüpfte Datenbankinhalt eine oder mehrere Informationen enthält, wird entweder die Singular- 

oder die Pluralvariante ausgegeben. Dies wird besonders in englischen Zitationsstilen für die 

Herausgeberangaben und Seitenangaben genutzt. Handelt es sich um einen einzelnen 

Herausgeber, wird dies häufig mit (Ed.) gekennzeichnet. Sind es mehrere, wird dies mit (Eds.) 

angegeben. Dabei steht die Singularvariante jeweils vor dem Singular/Plural-Operator (Hütchen), 

während die Pluralvariante dahintersteht.  

Abbildung 29: Operatoren zur Definition von Zitationsstilen 
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Formatierung 

Soll eine Angabe eine bestimmte Formatierung erhalten, z.B. kursiv gedruckt werden, markieren 

Sie den betreffenden Bereich und klicken oben auf das entsprechende Formatierungssymbol (Abb. 

29) 

Im Bereich Citation > Author Lists geben Sie an, wie bei mehreren Autoren vorgegangen werden 

soll. Sollen alle oder nur die ersten x Autoren genannt werden? Und durch welche Satzzeichen 

sollen mehrere Autorennamen voneinander getrennt werden? 

Im Bereich Citation > Author Name geben Sie an, wie die Autorennamen angegeben werden 

sollen. Sollen Vor- und Mittelnamen genannt werden? Sollen diese ausgeschrieben oder mit 

Initialen abgekürzt werden? Und in welcher Reihenfolge sollen diese genannt werden? 

Im Bereich Citation > Sort Order geben Sie an, in welcher Reihenfolge die Quellen genannt 

werden, wenn Sie an einer Stelle mehrere Quellen nennen.  

6.2 Die Angabe im Literaturverzeichnis 

Wählen Sie im Abschnitt Bibliography den Punkt Templates, um die Quellenangabe im 

Literaturverzeichnis zu definieren (Abb. 30). Definieren Sie alle Dokumenttypen (Reference 

Types), die Sie in Ihrer Arbeit verwenden. Um einen Dokumenttyp zu definieren, wählen Sie diesen 

im Feld Reference Types aus . Ein leeres Feld für den gewählten Dokumenttyp wird angezeigt.  

Über das Feld Insert Field (rechts oben) fügen Sie alle Felder ein, die Sie benötigen. Erstellen Sie 

Ihre Definition entsprechend der Beschreibung aus Kapitel 6.1.  

Auch für das Literaturverzeichnis haben Sie weitere Optionen, in denen Sie festlegen, wie Autoren- 

und Herausgebernamen dargestellt werden sollen, wie das Literaturverzeichnis sortiert werden soll 

u.ä. 

1 

2 

Abbildung 30: Den Eintrag im Literaturverzeichnis für verschiedene Dokumenttypen definieren 
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6.3 Groß-/Kleinschreibung im Literaturverzeichnis 

Sie haben vielleicht schon festgestellt, dass es Datenbanken gibt, bei denen Titel oder Autoren in 

Großbuchstaben importiert wird. Wollen Sie die Titel und Autoren in Ihrem Literaturverzeichnis 

einheitlich haben, gibt es verschiedene Möglichkeiten, dies zu erreichen.  

 

6.3.1 Groß-/Kleinschreibung von Titeln 

Diese Funktion ändert die Groß-

/Kleinschreibung des Titels für alle zitierten 

Referenzen. Sie wirkt sich nicht auf die Ansicht 

in EndNote aus, sondern nur auf die Ausgabe 

im Literaturverzeichnis.  

Bearbeiten Sie dazu Ihren Zitationsstil > Menü 

Tools > Output Style > Open Style Manager. 

Wählen Sie Ihren Zitationsstil und klicken Sie 

auf Edit, um ihn zu bearbeiten. 

Unter der Überschrift Bibliography finden Sie 

den Punkt Title Capitalization (Abb. 31). 

Wählen Sie, ob der Titel im Literaturverzeichnis 

so angegeben werden soll, wie er in EndNote 

eingegeben wurde, im Headline style (alle Worte 

groß geschrieben außer Artikel und 

Präpositionen) oder im Sentence style (erstes 

Wort großgeschrieben, sonst nur Substantive großgeschrieben). 

 

6.3.2 Groß-/Kleinschreibung von 

Autoren- und Herausgebernamen 

Für Autoren- und Herausgebernamen geben Sie direkt im Zitationsstil an, wie diese dargestellt 

werden sollen.  

Bearbeiten Sie dazu Ihren Zitationsstil > Menü Tools > Output Style > Open Style Manager. 

Wählen Sie Ihren Zitationsstil und klicken Sie auf Edit um ihn zu bearbeiten. 

Unter den Überschriften Citations, Bibliography, und Footnotes finden Sie jeweils die Punkte 

Author Name und Editor Name. 

Über das Capitalization-Drop-down-Menü wählen Sie, wie die Namen im Literaturverzeichnis, im 

Text oder in der Fußnote angezeigt werden sollen (s. Abb. 32). 

 

Abbildung 31: Title Capitalization im Zitationsstil 
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7 Kollaboration und Synchronisation mit EndNote Web 

EndNote Web ist ein webbasiertes Literaturverwaltungsprogramm, welches das orts- und 

rechnerunabhängige Arbeiten sowie das Arbeiten im Team ermöglicht. Angehörige der TUM 

können EndNote Web sowohl in Verbindung mit EndNote Desktop als auch ohne Desktop-Version 

nutzen.  

7.1 EndNote Web aktivieren 

Wenn Sie EndNote Desktop bereits installiert haben, können Sie, sofern Sie mit dem Internet 

verbunden sind, Ihren EndNote Web Account direkt aus EndNote Desktop heraus anlegen. Gehen 

Sie dazu im Menü Edit auf den Punkt Preferences und klicken Sie unter Sync auf den Button 

Enable Sync. Folgen Sie den weiteren Anweisungen. Legen Sie Ihren Account mit Ihrer TUM-E-

Mailadresse an. Alternativ können Sie den Weg über Library > Sync wählen oder in der linken 

Spalte über Sync Configuration.  

In EndNote Web haben Sie zusätzlich die Möglichkeit, sich das EndNote Web Plug-In 

herunterzuladen, das Ihnen beim schnellen Erfassen von Webseiten hilft.  

Sollten Sie bei der Installation von EndNote Desktop bereits einen EndNote Web Account haben, 

können Sie diesen an dieser Stelle ebenfalls direkt einbinden. 

Abbildung 32: Groß-/Kleinschreibung von Autorennamen bestimmen 
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Um EndNote Web ohne EndNote Desktop zu nutzen, folgen Sie in der Datenbank Web of Science 

dem Link zu EndNote im Menü Tools und legen sich mit Hilfe Ihrer TUM-E-Mailadresse einen 

EndNote Web-Account an (s. Abb. 33).  

 

7.2 Synchronisation zwischen EndNote Desktop und EndNote Web 

Sie können Daten sowohl von Ihrem Rechner auf Ihren EndNote Web Account transferieren als 

auch umgekehrt von Ihrem EndNote Web Account auf Ihren Rechner holen. 

Möchten Sie Daten zwischen verschiedenen Geräten synchronisieren, läuft die Synchronisation 

immer über EndNote Web. Ausgelöst wird der Datentransfer vom jeweiligen Endgerät aus.  

Es werden alle Referenzen inklusive Volltexten, Group Sets und allen Groups synchronisiert. 

Group Sets, Smart und Combined Groups werden in EndNote Web allerdings nicht angezeigt, 

nach der Synchronisation auf ein anderes Endgerät erscheinen diese wieder in EndNote.  

Da bei einer Synchronisation immer alles übertragen wird, ist es ratsam, insgesamt nur eine 

einzige EndNote Library anzulegen. Arbeitet man an mehreren Projekten, ist es sinnvoll, die 

Projekte über Group Sets und Groups zu gliedern.  

Neben der Synchronisation zwischen eigenen Geräten, lassen sich Gruppen und Libraries auch 

mit anderen EndNote-Usern teilen. Was jeweils geteilt wird variiert. Hier eine Übersicht (Abb. 34):  

 

Abbildung 34: Übersicht: Was wird wohin synchronisiert / geteilt? 

Abbildung 33:Link zu EndNote Web im Web of Science 
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7.3 Eine Group teilen 

Entsprechend der Custom Groups in EndNote Desktop können Sie auch hier Gruppen (Groups) 

anlegen. Diese können Sie mit bis zu 1000 anderen EndNote Web-Nutzern teilen, denen Sie 

individuell entweder nur Lese- oder Lese- und Schreibrechte zuweisen. Teilen Sie eine Group 

werden allerdings nur die bibliographischen Daten geteilt, nicht die Volltexte.  

Um eine Gruppe in EndNote Desktop für andere freizugeben (ab EndNote X9)   

1. gehen Sie mit der Maus auf die Gruppe, die Sie teilen möchten und öffnen mit einem 

Rechtsklick das Kontextmenü. Dort wählen Sie die Funktion Share Group. 

2. geben Sie unter dem Punkt Invite More People die E-Mailadressen der Personen ein, mit 

denen Sie die Gruppe teilen wollen.  

3. wählen Sie zu jeder Person aus, welche Rechte sie bekommen soll. Lese- oder Lese- und 

Schreibrechte.  

4. Im Feld Add A Message können Sie eine Nachricht an die Empfänger hinzufügen. 

Die E-Mailadresse muss hier nicht die Adresse sein, mit der die andere Person ihren EndNote 

Account angelegt hat.   

 

Um eine Gruppe in EndNote Web für andere freizugeben,   

1. gehen Sie im Menüpunkt Organisieren auf Eigene Gruppen verwalten, 

2. legen Sie eine neue Gruppe an oder wählen Sie eine bereits bestehende Gruppe aus, deren 

Einträge Sie teilen möchten, und gehen Sie auf den Button Freigabe verwalten. 

3. Fügen Sie nun Mitglieder hinzu und verteilen die gewünschten Bearbeitungsrechte. Um 

Mitglieder hinzuzufügen benötigen Sie die E-Mailadresse, mit der die Person Ihren EndNote 

Web Account angelegt hat. Beachten Sie jedoch, dass Sie Dateianhänge (z.B. PDFs) nicht 

teilen können. 

 

Während eine geteilte Library beim Gegenüber als neue Library erscheint, werden geteilte Groups 

nach der Synchronisation in der eigenen Library als geteilte Gruppen angezeigt (s. Abb. 35). 

Ab der Version EndNote X9 werden Gruppen, die anderen mit Ihnen teilen, bei Ihnen in EndNote 

Desktop unter Groups shared by others angezeigt. Sie sehen hier an erster Stelle die E-Mail-

Adresse der Person, die die Gruppe mit Ihnen geteilt hat (s. Abb. 36). An zweiter Stelle steht der 

Name der Gruppe. Der Name ist mit der Gruppe in EndNote Web verlinkt und öffnet die Gruppe 

dort automatisch. Dafür sehen Sie in EndNote Desktop jetzt nicht mehr, wie viele Referenzen in 

Abbildung 35: Anzeige geteilter 
Gruppen in EndNote Desktop 
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der Gruppe gespeichert sind und können diese auch nicht mehr im Programm selbst anzeigen 

lassen.  

 

Abbildung 36: Anzeige von Gruppen, die andere mit Ihnen geteilt haben, in EndNote Desktop 

 

7.4 Eine EndNote Library teilen 

Ihre gesamte EndNote Library können Sie mit bis zu 100 anderen EndNote Web-Usern teilen. Es 

werden dabei Referenzen, Volltexte und Gruppen geteilt. Bis zur Version X8 haben alle Mitglieder 

volle Bearbeitungsrechte. Ab X9 können Sie auch ein einfaches Leserecht vergeben.  

Um andere einzuladen, Ihre Library zu teilen, öffnen Sie die Library in Ihrer Desktop-Version und 

klicken im Menü File auf Share. Im folgenden Dialogfenster geben Sie die E-Mailadressen von 

allen Personen ein, mit denen Sie Ihre Library teilen 

wollen. Dies muss nicht die E-Mailadresse sein, mit 

der die jeweilige Person Ihren EndNote Web-

Account angelegt hat. Außerdem legen fest, ob die 

Person Lese-, oder Lese- und Schreibrechte 

bekommen soll. Die eingeladenen Personen 

bekommen per E-Mail eine Einladung, die Sie 

akzeptieren müssen, bevor Sie Zugriff auf Ihre 

Library haben.  

Solange die Einladung noch nicht akzeptiert wurde, 

wird der Status als Pending angegeben, sobald die 

Einladung angenommen wurde als Member (s. Abb. 

37). 

Sie können eine eigene Library teilen, aber beliebig 

viele andere Libraries, zu denen Sie von anderen 

eingeladen wurden, mitnutzen. Um eine fremde 

Library zu bearbeiten, wählen Sie in EndNote im 

Menü File den Befehl Open Shared Library. Sie 

können die Library nun je nach Rechten entweder 

lesen oder wie gewohnt lesen und bearbeiten. 

Libraries, die andere mit Ihnen teilen, sehen Sie nur in Ihrer Desktop-Version, nicht in Ihrem 

EndNote Web-Account.  

Änderungen, die in einer geteilten Library gemacht werden können Sie über die den Activity Feed 

nachvollziehen (s. Abb. 38). Es werden die letzten 500 Änderungen angezeigt. 

Abbildung 37: Andere EndNote-User zu einer 
Shared Library einladen 
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7.5 CWYW für EndNote Web 

In den Cite While You Write Preferences wählen Sie, ob CWYW auf EndNote Desktop oder Ihre 

EndNote Web Library zugreifen soll. Wählen Sie im Tab Application => EndNote online statt 

EndNote aus und bestätigen Sie dies mit OK (s. Abb. 39). 

 

Abbildung 38: Activity Feed 
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7.6 Kollaborative Nutzung der EndNote Library mit der Desktopversion 

Eine EndNote Library ist nicht dazu ausgelegt, von mehreren Personen gleichzeitig bearbeitet zu 

werden. Auch wenn die Datei auf einem gemeinsamen Laufwerk liegt, kann sie immer nur von 

einer Person bearbeitet werden. Für alle anderen ist die Datei gesperrt. Es ist in diesem Fall 

ebenfalls nicht möglich, eine schreibgeschützte Kopie zu öffnen.  

Folgende Lösung wäre jedoch denkbar: Es gibt im Team einen Bearbeiter, der die EndNote Library 

lokal auf seinem Rechner oder seinem Laufwerk gespeichert hat und pflegt. Er speichert eine 

schreibgeschützte Kopie der Library auf dem gemeinsamen Laufwerk zur Ansicht für alle Kollegen 

und ersetzt diese regelmäßig durch die aktualisierte Datei. Die Teammitglieder können die 

schreibgeschützte Datei parallel öffnen, darin suchen, Literaturlisten erstellen, Datensätze 

herauskopieren und in Word zitieren. 

7.7 Kompatibilität mit Programmen wie Evernote, Scrivener etc... 

Im Gegensatz zu Microsoft Word und unter Windows auch für OpenOffice Writer gibt es für andere 

Programme kein Cite While You Write Plug-In (CWYW). Arbeiten Sie mit einem anderen 

Programm wie beispielsweise Scrivener haben Sie folgende Möglichkeiten:  

Möchten Sie in Ihrem Text eine Quelle hinzufügen, markieren Sie den entsprechenden Eintrag in 

EndNote und kopieren diesen über Strg+C/Strg+V in Ihren Text. In Ihrem 

Textverarbeitungsprogramm wird die Zitation dann folgendermaßen aussehen: {Autornachname, 

Jahr #EndNote ID}. Haben Sie Ihre Arbeit fertig geschrieben und alle Quellen eingefügt, speichern 

Sie Ihren Text als .rtf- oder.odt-Datei.  

Diese lesen Sie anschließend in EndNote über das Menü Tools => Format Paper ein. Es öffnet 

sich ein Dialogfeld, in dem Ihnen EndNote alle Zitationen anzeigt, die es zuordnen kann (s. Abb. 

40). Über das Drop-down-Menü Output Style legen Sie fest, in welchem Zitierstil Zitationen und 

Abbildung 39: Cite While You Write Preferences in 
Word 
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Literaturverzeichnis formatiert werden. Klicken Sie anschließend auf Format und wählen Sie 

Speicherort, Dateiformat und Dateinamen aus. 

Die vorläufigen Zitationen in geschweiften Klammern werden ersetzt und das Literaturverzeichnis 

erstellt. Anders als in Word wird dieses Literaturverzeichnis beim Einfügen eines neuen 

Quellennachweises nicht automatisch aktualisiert, da es sich hier um statischen Text handelt und 

nicht um aktive Feldfunktionen. Wollen Sie nachträglich noch Zitationen hinzufügen oder 

verändern, verwenden Sie bitte Ihren Ursprungstext, der noch die Zitationen in geschweiften 

Klammern enthält, sonst wird Ihnen beim neuerlichen Formatieren ein zweites Literaturverzeichnis 

erstellt. Passen Sie diesen Text an und formatieren Sie das Dokument erneut.  

 

8 Manuscript Matcher – Wie finde ich das passende 

Journal für meinen Artikel? 

Über den EndNote Web Account bietet EndNote die Möglichkeit nach Journals zu suchen, in 

denen Sie Ihren eigenen Artikel inhaltlich sinnvoll platzieren können. Diese Funktion nennt sich 

Manuscript Matcher. Sie finden die Funktion in Ihrem EndNote Web Account über das Menü 

Übereinstimmung (Abb. 41). 

 

Abbildung 40 : Zitation und Literaturverzeichnisse in .rtf- oder. odt-Dateien formatieren 
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Dort geben Sie Titel und Abstract Ihres Artikels ein. Ihre Referenzen sind nicht zwingend 

notwendig, ermöglichen jedoch ein sehr viel besseres Suchergebnis. Wenn sie Ihre Referenzen in 

einem Ordner in EndNote Web gesammelt haben, wählen Sie diesen Ordner im Feld Referenzen 

aus (Abb. 42).  

Abbildung 41: Manuscript Matcher in EndNote Web aufrufen 

Abbildung 42: Informationen zum Artikel eintragen 
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Ab Version EndNote X9 können Sie diese Funktion auch aus EndNote Desktop oder Word heraus 

starten.  

EndNote Desktop: Menü Groups > Manuscript Matcher (für diese Funktion muss eine Group 

ausgewählt sein. 

Word-Add-In: EndNote-Toolbar > Manuscript Matcher (s. Abb. 43)  

Hier werden die Quellen aus dem ausgewählten Ordner (Desktop), bzw. dem Word-Dokument 

automatisch übernommen.  

Anhand des Titels, des Abstract und ggf. der Quellen sucht der Manuscript Matcher im Web of 

Science nach Journals, in denen inhaltlich ähnliche Artikel veröffentlicht werden. Das Resultat 

kann z.B. so aussehen (s. Abb. 44):  

Sie erhalten bis zu zehn Vorschläge (s. Abb. 44). Für jedes Journal sehen Sie, welche Begriffe 

inhaltlich wie stark mit den dort diskutierten Themen übereinstimmen (1), den Impact Factor (2) 

und in welchem Fachbereich dieses Journal zu verorten ist (3). Sie erhalten Informationen über 

den Herausgeber der Zeitschrift (4), einen Link zur Homepage, auf der Sie sich weiter informieren 

können (5) und einen direkten Link, über den Sie Ihren Artikel bei der jeweiligen Zeitschrift 

einreichen können (6). In Abb. 42 können Sie außerdem sehen, dass Open Access Zeitschriften 

Abbildung 44: Journal-Empfehlung durch den Manuscript-Matcher 

Abbildung 43: Manuscript Matcher im Word-Add-In 
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als solche gekennzeichnet sind (7). Ein Video zum Manuscript Matcher finden Sie hier: 

https://youtu.be/rt0rT0wemrI. 

Bitte beachten Sie, dass dies keine Garantie darstellt, dass Ihr Artikel auch akzeptiert wird.  

9 Weitere Importmöglichkeiten 

Neben den bereits im EndNote Basiskurs vorgestellten Möglichkeiten, Literatur in EndNote 

aufzunehmen (manuell, Export aus dem Online-Katalog, Export aus Datenbanken, Online Search 

aus EndNote heraus), gibt es weitere Möglichkeiten des Imports. So bietet Endnote z.B. eine 

Bookmarklet an, um Internetquellen schnell zu übernehmen, während Google Scholar einen 

speziellen Downloadlink für den Import in Endnote zur Verfügung stellt.  

 

9.1 EndNote Capture Bookmarklet 

Mithilfe des EndNote Capture Bookmarklets lassen sich Internetquellen aufnehmen. Das 

Bookmarklet finden Sie in Ihrem Endnote Web Account im Menü Herunterladen. Ziehen Sie das 

Bookmarklet Referenz erfassen per Drag-and-Drop in die Symbolleiste Ihres Browsers (s. Abb. 

45).  

Wollen Sie bspw. eine Internetseite als Referenz speichern, klicken Sie auf das Bookmarklet in 

Ihrem Browser. Es öffnet sich folgendes Fenster (s. Abb. 46):  

EndNote übernimmt die Daten, die es zur Referenz finden kann. Gerade bei Webseiten sind diese 

Informationen häufig unvollständig und fehlerhaft. Prüfen und ergänzen Sie die Daten daher 

besonders sorgfältig. Anschließend wählen Sie, ob Sie die Referenz in Endnote (Desktop) oder 

direkt in Ihrem EndNote Web Account (my.endnote.com) speichern wollen. Klicken Sie auf Ort, um 

die Referenz zu speichern.  

Abbildung 45: EndNote Capture Bookmarklet einrichten 

https://youtu.be/rt0rT0wemrI
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9.2 Import aus Google Scholar 

In Google Scholar haben Sie die Möglichkeit, sich einen direkten Link zum Import von Referenzen 

in Endnote anzeigen zu lassen (s. Abb.47).  

Dazu gehen Sie in Google Scholar in die Einstellungen und dort in den Tab Suchergebnisse. Dort 

wählen Sie unter dem Punkt Bibliographie-Manager aus, dass Ihnen die Links zum Import von 

Literaturverweisen in EndNote angezeigt werden (Abb. 48). Wählen Sie EndNote aus dem Drop-

down-Menü aus. Speichern Sie die geänderten Einstellungen. Bei Ihrer nächsten Recherche wird 

Ihnen für jeden Titel ein Link zum direkten Import in EndNote angezeigt. Importieren Sie die Daten 

Abbildung 46: Speichern einer Internetseite mit dem EndNote Capture Bookmarklet 

Abbildung 47: EndNote-Import-Link in Google Scholar 
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wie beim Import aus Datenbanken oder Katalogen über den Direktimport, indem Sie die 

Importdatei direkt mit Endnote öffnen.  

 

  

Abbildung 48: EndNote-Import-Link in Google Scholar einrichten 
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10  Kontakt und Support 

Bei Fragen zu EndNote können Sie auf verschiedenen Wegen Hilfe und Unterstützung bekommen: 

10.1 Hilfe durch EndNote 

Handbuch 

Im Programm können Sie mit F1 das EndNote Handbuch öffnen. 

Technischer Support 

Technischen Support bekommen Sie über: https://support.clarivate.com/s/  

10.2 Hilfe an der TUM 

Sie können sich bei Fragen auch sehr gerne an die Universitätsbibliothek wenden: 

literaturverwaltung@ub.tum.de.  

Video-Tutorials und Skripten 

Video-Tutorials und Skripten finden Sie auch in unserem eKurs unter: 

https://www.ub.tum.de/ekurs/literaturverwaltung-mit-endnote-aufbaukurs  

TUM-Zitierleitfaden 

Wenn Sie Fragen zum Zitieren haben, hilft der TUM-Zitierleitfaden 

https://mediatum.ub.tum.de/node?id=1231945  

Literaturverwaltungs- und Zitiersprechstunde der Universitätsbibliothek der TUM 

Zusätzlich zu unseren Kursen zur Literaturverwaltung bieten wir eine 

Literaturverwaltungssprechstunde an (online, telefonisch oder präsent), in der individuelle Fragen 

besprochen werden können.  

Terminvereinbarung unter: https://www.ub.tum.de/sprechstunde-literaturverwaltung-zitieren. 

10.3 Sonstiges 

Um Ihre Daten zu sichern, sollten Sie regelmäßig Sicherungskopien erstellen. Sie haben dabei 

zwei Möglichkeiten: Entweder Sie speichern Ihre Daten in Form einer Compressed Library im 

.enlx-Format oder Sie exportieren die Library im .txt-, .rtf-, .htm- oder .xml-Format. Beide 

Möglichkeiten finden Sie im Menü File. 

Connection Files, Import Filter & Output Styles 

Sie können Ihre eigene EndNote-Installation nach Ihren Bedürfnissen weiter anpassen.  

Connection Files* 

Connection Files zu weiteren Katalogen und Datenbanken können Sie auf der EndNote Website 

herunterladen: http://www.endnote.com/support/enconnections.asp  

https://support.clarivate.com/s/
mailto:literaturverwaltung@ub.tum.de
https://www.ub.tum.de/ekurs/literaturverwaltung-mit-endnote-aufbaukurs
https://mediatum.ub.tum.de/node?id=1231945
https://www.ub.tum.de/sprechstunde-literaturverwaltung-zitieren
http://www.endnote.com/support/enconnections.asp
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Import Filter* 

Downloads für zusätzliche Import Filter sind ebenfalls auf der EndNote Website verfügbar: 

http://www.endnote.com/support/enfilters.asp  

Updates 

EndNote Updates finden Sie unter: http://endnote.com/downloads/available-updates 

Bitte beachten Sie, dass Sie EndNote erst deinstallieren müssen, bevor Sie eine neuere Version 

installieren. 

Output Styles (Zitationsstile) 

Weitere Zitationsstile finden Sie unter: http://www.endnote.com/support/enstyles.asp     
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